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Abstrakt

Práce se zabývá zmapováním možností
sledování paprsku v reálném čase v Unity
a chováním této funkce v herním nasazení.
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Thesis explores possibilites of real-time
ray tracing in Unity and its application
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Kapitola 1

Úvod

Sledování paprsku v reálném čase neboli real-time ray tracing je v Unity
stále relativně nová sada funkcí a tato sada funkcí je v současnosti v Unity
dostupná ve formě předbežný přístup. Tato sada funkcí byla přidána do Unity
v roce 2019 ve verzi 2019.3. Tato práce se zabývá otestováním této sady funkcí
z hlediska grafické kvality a výkonu. Testy jsou prováděny jak na scénách
snažících se přiblížit realitě tak na jednoduchý scénách sloužících k otestování
konkrétní funkcionality.
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Kapitola 2

Terminologie

Termín sledování paprsku v reálném čase je v práci používán i v anglické verzi
real-time ray tracing, případně je použita zkratka RTRT. Názvy položek v
menu, nastavení, a dalších prvků Unity editoru jsou ponechány v anglickém
jazyce, taktéž jsou v případě některých odborných termínů použity anglické
názvy.
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Část I

RTRT a Unity
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Kapitola 3

RTRT

Ray casting je proces hledání objektu(většinou nejbližšího) v cestě paprsku.
Paprsky je vyslán z pixelu kamery a cestuje dokud nenarazí do nejbližšího ob-
jektu v cestě. Z bodu dopadu paprsku muže být vyslán nový paprsek směrem
ke zdroji světla, aby se zjistilo zda je tento bod zastíněn. Ray tracing využívá
mechanismus ray castingu tak, že rekurzivně skládá příspěvky světla z reflek-
tivních a refraktivních objektů. Například pokud paprsek narazí do zrcadla z
bodu dopadu je vržen paprsek odrazu ve směru odrazu, místo dopadu tohoto
paprsku ovlivní jak bude zrcadlo nakonec vykresleno. Průhledné objekty nao-
pak vysílají parsek refrakce, přičemž některé objekty mohou vyslat z jednoho
místa dopadu oba typy paprsků současně. Tento proces probíhá rekurzivně
a většinou je omezen limitem počtu odrazů. Tímto vznikne strom paprsků,
který je pak od listů ke kořeni vyhodnocen, aby byla získána výsledná barva.
V případě, že je vykreslováno zastínění jsou také vrhány paprsky směrem
ke zdrojům světla. Mnoho metod ray tracingu používá z důvodu snížení
výpočetní náročnosti zjednodušení vlastností objektů. Například klasický ray
tracing pracuje tak, že ignoruje hrubost a lesklost povrchu objektu, místo toho
je povrch objektu brán jako zcela lesklý a hladký, zároveň jsou zdroje světla
zjednodušeny na reprezentaci pomocí směru nebo jednoho bodu. Ray tracing
obecně nemusí být vypočítáván v reálném čase, ale osvětlení scény může být
dopředu před-počítáno a výsledek ray tracingu v ní může být obsažen. Při
běhu je pak používána jednodušší metoda osvětlování. V případě real-time ray
tracingu je osvětlení pomocí ray tracingu vypočítáváno za běhu scény.[ea19]
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Kapitola 4

RTRT v Unity

pozn.Tato kapitola je parafrází části dokumentace HDRP 7.3 týkající se
sledování paprsku. [Tec]

4.1 Hardwarové požadavky

Unity RTRT beží pouze na novějších grafických kartách značky NVIDIA,
přičemž pouze nejnovější generace grafických karet poskytuje hardwarovou
akceleraci RTRT. Hardwarová akcelerace sledování paprsku je k dispozici na
následujících GPU:

.• NVIDIA GeForce RTX 2060, RTX 2080 Super, RTX 2070, RTX 2070
Super, RTX 2080, RTX 2080 Super, RTX 2080 Ti NVIDIA TITAN RTX.• NVIDIA Quadro RTX 3000 (pouze pro notebook), RTX 4000, RTX
5000, RTX 6000, RTX 8000

NVIDIA také poskytuje ray tracing fallback pro některé grafické karty
předchozí generace:

. NVIDIA GeForce GTX
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4. RTRT v Unity ....................................
. Turingova generace: GTX 1650, GTX 1660 Super, GTX 1660 Ti. Pascal generace: GTX 1060, GTX 1070, GTX 1080, GTX 1080 Ti. NVIDIA TITAN V. NVIDIA Quadro: P4000, P5000, P6000, V100

Použití grafické karty bez hardwarové akcelerace má však zásadní dopad
na rychlost vykreslování.

4.2 Softwarové požadavky

Unity real-time ray vyžaduje ke svému běhu DirectX12, z tohoto důvodu
beží v současnosti pouze naoperačním systému Windows s nainstalovaným
DirectX12. Pro použití Unity Real-Time Ray Tracing je nutné použít Unity
verze 2019.3 nebo novější a zároveň musí být použit HDRP projekt, přičemž
použitá verze HDRP musí být alespoň HDRP 7.1.

4.3 HDRP

HDRP(High definition render pipeline) je vykreslující pipeline sloužíci k
vytváření projektů ve vyšší grafické kvalitě než vestavěný vykreslovací pipeline
Unity. Nejzásadnějším rozdílem mezi HDRP a vestavěným vykreslovacím
pipeline je, že HDRP využívá jinak definované materiály a jinou sadu shaderů.

4.4 Základní nastavení

Před použitím funkcí sledování paprsku v projektu HDRP je nutné nastavit
projekt HDRP pro podporu sledování paprsků. HDRP podporuje sledování
paprsku pouze pomocí rozhraní DirectX 12 API, takže sledování paprsku
funguje pouze v editoru Unity Editor nebo Windows Unity Player, když se
vykreslují s DirectX 12. Je třeba změnit výchozí grafické API projektu HDRP
z DirectX 11 na DirectX 12 .
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.................................. 4.4. Základní nastavení

Existují dva způsoby, jak toho dosáhnout:

. Použitím Průvodce Render Pipeline. Ručním nastavením

Průvodce Render Pipeline umožňuje provézt základní nastavení sledování
paprsku v HDRP projektu velmi jednoduchím způsobem...1. Průvodce Render Pipeline je možné otevřít v Window > Render Pipeline

vybráním HD Render Pipeline Wizard...2. Následně je nutné vybrat záložku HDRP + DXR...3. Pak už jen stačí kliknout na tlačítko Fix All

Následně je ještě nutné správně nastavit kamery. Toho lze dosáhnout buď
změnou výchozího nastavení kamer nebo změnou nastavení konkrétní kamery.

Výchozí nastavení lze změnit následujícím způsobem:..1. Otevřením okna Project Settings v menu: Edit > Project Settings a
následně vybráním záložky HDRP Default Settings...2. Následně je nutné vybrat v rozbalovácí nabídce Camera, poté rozbalit
sekci Rendering a následně je v sekci potřeba zapnout Ray Tracing.

Nastavení Ray Tracing pro specifickou kameru:..1. Nejprve je nutné vybrat konkrétní kameru ve scéně...2. Následně je v sekci General, nutné povolit Custom Frame Settings...3. Tímto je umožněno v sekci Rendering section, povolení Ray Tracingu
pro tuto konkrétní kameru.

11 ctuthesis t1606152353



4. RTRT v Unity ....................................
4.5 Ray-Traced Ambient Occlusion

Ray-Traced Ambient Occlusion je jedna z funkcí Ray Tracing obsažená v
HDRP. Jedná se o alternativu k funkci HDRP screen space ambient occlusion,
oproti které je přesnější, protože může používat data mimo obrazovku. Tato
funkce aproximuje tlumení ambientního osvětlení zastíněním.

Protože je tato funkce alternativou k screen space Ambient Occlusion
Volume Override, je její počáteční nastavení velmi podobné...1. Nejprve je nutné povolit screen space ambient occlusion v HDRP Assetu...2. Následně je ve Frame Settings kamer nutné povolit Screen Space Ambient

Occlusion a ray tracing...3. Ještě je nutné přidat efekt do Volume ve scéně.

HDRP Asset řídí, jaké funkce jsou k dispozici v HDRP projektu. Pro
aktivaci podpory HDRP a přidělení paměti pro ray-traced ambient occlusion
je nutné:..1. Vybrat HDRP Asset v projektu...2. V sekci Lighting povolit Screen Space Ambient Occlusion.

Kamery používají Frame Settings k rozhodnutí, jak vykreslit scénu. Je
možné nastavit, aby byla funkce ray-traced ambient occlusion ve výchozím
nastavení kamer zapnutá:..1. Nejprve je nutné otevřít okno Project Settings v menu: Edit > Project

Settings a následně vybrat záložku HDRP Default Settings...2. Následně je nutné vybrat v rozbalovácí nabídce Camera, poté rozbalit
sekci Rendering a následně je v sekci potřeba zapnout Ray Tracing...3. Nakonec je v sekci potřeba Lighting potřeba zapnout Screen Space
Ambient Occlusion.

ctuthesis t1606152353 12



.............................4.5. Ray-Traced Ambient Occlusion

Funkci ray-traced ambient occlusion je možné povolit i pro jednotlivou
kameru:..1. Nejprve je nutné vybrat konkrétní kameru ve scéně...2. Následně je v sekci General, nutné povolit Custom Frame Settings...3. Potom je v sekci Rendering nutné povolit ray tracing a v sekci Lighting

povolit Screen Space Ambient Occlusion.

Ray-Traced Ambient Occlusion používá Volume framework, takže pro
aktivaci této funkce a úpravu jejích vlastností je třeba přidat Ambience
Occlusion override do Volume ve sceně. Postup:..1. Nejprve je nutné vybrat ve scéně objekt obsahující Volume..2. Následně je nutné přidat override Add Override > Lighting a kliknout

na Ambient Occlusion. HDRP nyní bude aplikovat screen space ambient
occlusion na jakoukoli kameru, na kterou má tento Volume vliv...3. V Inspektoru pro Ambient Occlusion Volume Override je ještě nutné
povolit ray tracing.

Vlastnosti ovlivňující chování Ray-Traced Ambient Occlusion

. Ray Tracing - Umožňuje HDRP používat ray tracing k vyhodnocování
efektu ambient occlusion.. Intensity - Řídí intinzitu efektu ambient occlusion.. Direct Lighting Strength - Určuje, do jaké míry ambient occlusion ovliv-
ňuje přímé osvětlení.. LayerMask - Definuje vrstvy, pro které HDRP zpracovává tento efekt.. Ray Length - Řídí délku paprsků, které HDRP používá pro ray tracing.
Určuje z jaké vzdálenosti jsou data pro tento efekt sbírána.. Sample Count - Řídí počet paprsků, které HDRP používá na pixel a
snímek. Zvýšení této hodnoty lineárně zvyšuje dobu běhu..Denoise - Povoluje filtr, který HDRP používá k odstranění šumu z
ambient occlusion.. Denoiser Radius - Řídí poloměr filtru. Vyšší hodnota více snižuje šum.
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4. RTRT v Unity ....................................
4.6 Ray-Traced Contact Shadows

Ray-Traced Contact Shadows je jedna z funkcí Ray Tracing obsažená v
HDRP. Jedná se o alternativu k funkci HDRP Contact Shadow, oproti
které je přesnější, protože může používat data mimo obrazovku. Tato funkce
umožňuje vykreslovat drobné detaily stínů.

Protože je tato funkce alternativou k contact shadows Volume Override, je
její počáteční nastavení velmi podobné...1. Nejprve je nutné povolit contact shadows v HDRP Assetu...2. Následně je nutné povolit contact shadows pro kamery...3. Ještě je nutné přidat efekt do Volume ve scéně.

HDRP Asset řídí, jaké funkce jsou k dispozici v HDRP projektu. Pro
aktivaci podpory HDRP a přidělení paměti pro contact shadows je nutné:..1. Vybrat HDRP Asset v projektu...2. V sekci Lighting > Shadows povolit Contact Shadows.

Kamery používají Frame Settings k rozhodnutí, jak vykreslit scénu. Je
možné nastavit, aby byla funkce ray-traced contact shadows ve výchozím
nastavení kamer zapnutá:..1. Nejprve je nutné otevřít okno Project Settings v menu: Edit > Project

Settings a následně vybrat záložku HDRP Default Settings...2. Následně je nutné vybrat v rozbalovácí nabídce Camera, poté rozbalit
sekci Lighting a následně je v sekci potřeba zapnout Contact Shadows.

Funkci ray-traced contact shadows je možné povolit i pro jednotlivou
kameru:..1. Nejprve je nutné vybrat konkrétní kameru ve scéně.

ctuthesis t1606152353 14



.............................4.7. Ray-Traced Global Illumination..2. Potom je v sekci Lighting nutné povolit Contact Shadows.

Ray-Traced Contact Shadows používá Volume framework, takže pro aktivaci
této funkce a úpravu jejích vlastností je třeba přidat Contact Shadows override
do Volume ve sceně. Postup:..1. Nejprve je nutné vybrat ve scéně objekt obsahující Volume..2. Následně je nutné přidat override Add Override > Lighting a kliknout na

Contact Shadows. HDRP nyní bude aplikovat funkci Contact Shadows
na jakoukoli kameru, na kterou má tento Volume vliv...3. V Inspektoru pro Ambient Occlusion Volume Override je ještě nutné
povolit ray tracing.

Chcete-li, aby HDRP počítal a používal Ray-Traced Contact Shadows,
musíte je povolit pro Light...1. Nejprve je nutné vybrat ve scéně objekt obsahující světlo...2. Ve vlastnostech světla Shadows > Contact Shadows je potřeba zaškrtnout

políčko Enable. To zobrazí vlastnost Ray Tracing...3. Zbýva jen zaškrtnout políčko Ray Tracing.

4.7 Ray-Traced Global Illumination

Ray-Traced Global Illumination je jedna z funkcí Ray Tracing obsažená v
HDRP. Jedná se o přesnější alternativu k použití Light Probes a Light Maps.
Tato funkce počítá globální osvětlení pomocí metody ray tracing.

Kamery používají Frame Settings k rozhodnutí, jak vykreslit scénu. Je
možné nastavit, aby byla funkce ray-traced global illumination ve výchozím
nastavení kamer zapnutá:..1. Nejprve je nutné otevřít okno Project Settings v menu: Edit > Project

Settings a následně vybrat záložku HDRP Default Settings.
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4. RTRT v Unity ......................................2. Následně je nutné vybrat v rozbalovácí nabídce Camera, poté rozbalit
sekci Rendering a následně je v sekci potřeba zapnout Ray Tracing.

Funkci ray-traced global illumination je možné povolit i pro jednotlivou
kameru:..1. Nejprve je nutné vybrat konkrétní kameru ve scéně...2. Následně je v sekci General, nutné povolit Custom Frame Settings...3. Potom je v sekci Rendering nutné povolit ray tracing.

Ray-Traced Global Illumination používá Volume framework, takže pro akti-
vaci této funkce a úpravu jejích vlastností je třeba přidat Global Illumination
override do Volume ve sceně. Postup:..1. Nejprve je nutné vybrat ve scéně objekt obsahující Volume..2. Následně je nutné přidat override Add Override > Lighting a kliknout

Global Illumination...3. V Inspektoru pro Global Illumination Volume Override je ještě nutné
povolit ray tracing. HDRP nyní bude aplikovat global illumination na
jakoukoli kameru, na kterou má tento Volume vliv.

Vlastnosti ovlivňující chování Ray-Traced Global Illumination

. Ray Tracing - Umožňuje HDRP používat ray tracing k vyhodnocování
funkce .. LayerMask - Definuje vrstvy, pro které HDRP zpracovává tento efekt.. Ray Length - Řídí délku paprsků, které HDRP používá pro ray tracing.
Pokud paprsek neprotne objekt, vrátí barvu oblohy.. Clamp Value - Nastavte hodnotu pro ovládání prahu, který HDRP
používá k připnutí předem exponované hodnoty. To snižuje rozsah hodnot
a činí global illumination stabilnější při odstranění šumu, ale snižuje
kvalitu.. Denoise - Povoluje filtr, který HDRP používá k odstranění šumu z global
illumination.
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................................ 4.8. Ray-Traced Reflections

. Denoiser Radius - Vyšší hodnota více snižuje šum.. Second Denoiser Pass - Povoluje druhý průchod odstraňovače šumu.. Second Denoiser Radius - Řídí poloměr filtru pro druhý průchod odstra-
ňovače šumu.. Upscale Radius - Řídí poloměr up-scaleru, který HDRP používá k vy-
tváření Global Illumination. Čím větší je poloměr, tím více sousedících
objektů HDRP používá k vytváření Global Illumination. Vyšší hodnota
zvyšuje kvalitu.. Full Resolution - Povolení této funkce zvýšuje počet paprsků na jeden
paprsek na pixel a snímek. Pokud není zapnutá počet paprsků je jeden
paprsek na čtyři pixely a snímek.. Sample Count - Řídí počet paprsků, které HDRP používá na pixel a
snímek. Zvýšení této hodnoty lineárně zvyšuje dobu běhu.. Bounce Count - Řídí maximální počet odrazů, kterého mohou paprsky
Global Illumination dosáhnout. Zvýšení této hodnoty exponenciálně
zvyšuje dobu provádění.

4.8 Ray-Traced Reflections

Ray-Traced Reflections je jedna z funkcí Ray Tracing obsažená v HDRP.
Jedná se o alternativu k funkci HDRP Screen Space Reflection, oproti které
je přesnější, protože může používat data mimo obrazovku. Tato funkce počítá
odrazy.

Protože je tato funkce alternativou k Screen Space Reflection Volume
Override, je její počáteční nastavení velmi podobné...1. Nejprve je nutné povolit screen space reflection v HDRP Assetu...2. Následně je nutné povolit screen space reflection pro kamery...3. Ještě je nutné přidat efekt do Volume ve scéně.

HDRP Asset řídí, jaké funkce jsou k dispozici v HDRP projektu. Pro
aktivaci podpory HDRP a přidělení paměti pro Ray-Traced Reflections je
nutné:
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4. RTRT v Unity ......................................1. Vybrat HDRP Asset v projektu...2. V sekci Lighting povolit Screen Space Reflection.

Kamery používají Frame Settings k rozhodnutí, jak vykreslit scénu. Je
možné nastavit, aby byla funkce ray-traced contact reflection ve výchozím
nastavení kamer zapnutá:..1. Nejprve je nutné otevřít okno Project Settings v menu: Edit > Project

Settings a následně vybrat záložku HDRP Default Settings...2. Následně je nutné vybrat v rozbalovácí nabídce Camera, poté rozba-
lit sekci Lighting a následně je v sekci potřeba zapnout Screen Space
Reflection...3. Potom je v sekci Rendering nutné povolit ray tracing.

Funkci ray-traced reflections je možné povolit i pro jednotlivou kameru:..1. Nejprve je nutné vybrat konkrétní kameru ve scéně...2. Potom je v sekci Lighting nutné povolit Screen Space Reflection a v sekci
Rendering povolit Ray Tracing.

Ray-Traced Reflections používá Volume framework, takže pro aktivaci této
funkce a úpravu jejích vlastností je třeba přidat Screen Space Reflection
override do Volume ve sceně. Postup:..1. Nejprve je nutné vybrat ve scéně objekt obsahující Volume..2. Následně je nutné přidat override Add Override > Lighting a kliknout

na Screen Space Reflection...3. V Inspektoru pro Screen Space Reflection Override je ještě nutné povolit
ray tracing. HDRP nyní bude aplikovat funkci Ray-Traced Reflections
na jakoukoli kameru, na kterou má tento Volume vliv.

Ray-Traced Reflections používá Volume framework, takže pro aktivaci této
funkce a úpravu jejích vlastností je třeba přidat n override k Volume ve vaší
Scene. Postup:
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................................ 4.8. Ray-Traced Reflections..1. The labels consists of sequential numbers...2. The numbers starts at 1 with every call to the enumerate environment.

Vlastnosti ovlivňující chování Ray-Traced Reflections

. Ray Tracing - Umožňuje HDRP používat ray tracing k vyhodnocování
funkce..Minimum Smoothness - Řídí minimální hodnotu smoothness pro pixel,
ve kterém HDRP zpracovává ray-traced reflections.. Smoothness Fade Start - Určuje hodnotu smoothness od které se začíná
odraz ztrácet.. Reflect Sky - Povolení určuje HDRP, že by má používat oblohu jako
fall-back pro ray-traced reflections, když paprsek nenalezne průnik.. LayerMask - Definuje vrstvy, pro které HDRP zpracovává tento efekt.. Ray Length - Řídí délku paprsků, které HDRP používá pro ray tracing.
Pokud paprsek neprotne objekt, vrátí barvu oblohy nobe černou barvu
pokud je zákázána Reflect Sky.. Clamp Value - Nastavte hodnotu pro ovládání prahu, který HDRP
používá k připnutí předem exponované hodnoty. To snižuje rozsah hodnot
a činí odrazy stabilnější při odstranění šumu, ale snižuje kvalitu.. Denoise - Povoluje filtr, který HDRP používá k odstranění šumu z global
illumination.. Denoiser Radius - Vyšší hodnota více snižuje šum.. Upscale Radius - Řídí poloměr up-scaleru, který HDRP používá k vy-
tváření Global Illumination. Čím větší je poloměr, tím více sousedících
objektů HDRP používá k vytváření odrazů. Vyšší hodnota zvyšuje kva-
litu.. Full Resolution - Povolení této funkce zvýšuje počet paprsků na jeden
paprsek na pixel a snímek. Pokud není zapnutá počet paprsků je jeden
paprsek na čtyři pixely a snímek.. Sample Count - Řídí počet paprsků, které HDRP používá na pixel a
snímek. Zvýšení této hodnoty lineárně zvyšuje dobu běhu.. Bounce Count - Řídí maximální počet odrazů, kterého mohou paprsky
odrazů dosáhnout. Zvýšení této hodnoty exponenciálně zvyšuje dobu
provádění.
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4. RTRT v Unity ....................................
4.9 Ray-traced shadows

Ray-traced shadows jsou stíny, které HDRP generuje sledováním paprsků
světla z následujících světelných zdrojů:

. Directional. Point. Spot. Rectangle

Povolení Ray-traced shadows nahradí mapy stínů pro neprůhledné objekty.
Všechny Ray-traced shadows jsou screen space shadows. To znamená, že je
HDRP ukládá do screen space bufferu, který obsahuje informace pro každý
pixel na obrazovce, který je v depth buffer (ten ukládá pouze neprůhledné
objekty). Funkci Ray-traced shadows je také nutné povolit v HDRP assetu a
pro kamery. Způsob je obdobný jako u předchozích efektů. Tato funkce také
vyžaduje úpravu mapy stínů.

Směrové světlo Ray-traced shadows nabízejí alternativu ke cascade shadow
map, kterou Directional Lights používají pro neprůhledné GameObjects.

Ray-traced shadows umožňují průhledným a propustným GameObjects,
osvětleným Directional Lights, aby vrhaly barevné stíny.

Vlastnosti ovlivňující Ray-traced shadows pro Directional Lights Vlastnost
Popis Sun Angle Nastavuje velikost Slunce na obloze ve stupních. Například
hodnota pro Slunce na Zemi je 0,53 °. Sample Count Řídí počet paprsků,
které HDRP používá na pixel a snímek. Vyšší hodnoty vytvářejí přesnější
stíny. Zvýšení této hodnoty lineárně zvyšuje dobu provádění. Color Shadow
Umožňuje průhledným a propustným GameObjects vrhat barevné stíny.
Denoise Umožňuje časoprostorovému filtru, který HDRP používá k odstranění
šumu ze stínů sledovaných paprskem, aby byly hladší. - Denoiser Radius Řídí
poloměr časoprostorového filtru.

Point And Spot Light Stíny sledované paprskem nabízejí alternativu ke
stínové mapě, kterou Point and Spot Lights používají pro neprůhledné Game-
Objects. HDRP stále hodnotí osvětlení Point Light jako přicházející z jednoho
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..................................4.9. Ray-traced shadows

bodu v prostoru (světlo je přesné), ale hodnotí stínování, jako by světlo
přicházelo z povrchu koule. Na druhé straně HDRP vyhodnocuje osvětlení
Spot Light jako přicházející z jednoho bodu v prostoru, ale hodnotí stínování,
jako by světlo přicházelo z povrchu kužele.

Ray-traced stíny nabízejí možnost poloprůhledných stínů pro Point Lights
vrhaných průhlednými a propustnými GameObjects.

Vlastnosti ovlivňující Ray-traced shadows pro Point Lights

. Sample Count - Řídí počet paprsků, které HDRP používá na pixel a
snímek. Nízký počet vzorků vytváří zašumněnější obraz, který vyžaduje
více denoisingu. Zvýšení této hodnoty lineárně zvyšuje dobu provádění.

. Semi-Transparent Shadow - Umožňuje průhledným a propustným Game-
Objects vrhat poloprůhledné stíny.

. Radius - Nastavuje sférický poloměr světla, které HDRP používá k
vyhodnocení stínů. Tím se zvětšuje velikost povrchu, který emituje
světlo.

. Denoise - Povoluje filtr, který HDRP používá k odstranění šumu ze stínů.

. Denoiser Radius - Řídí poloměr filtru.

Rectangle light Stíny sledované paprskem nabízejí alternativu k exponential
variance shadow map, kterou obdélníková světla používají pro neprůhledné
GameObjects.

Vlastnosti ovlivňující Ray-traced shadows pro Rectangle Lights

. Sample Count - Řídí počet paprsků, které HDRP používá na pixel a
snímek. Zvýšení těchto hodnot lineárně zvyšuje dobu provádění.

. Denoise - Povoluje filtr, který HDRP používá k odstranění šumu ze stínů.

. Denoiser Radius - Řídí poloměr filtru.
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4. RTRT v Unity ....................................
4.10 Light Cluster

Chcete-li vypočítat odrazy světla pro efekty sledované paprskem, jako jsou
odrazy, globální osvětlení, rekurzivní vykreslování nebo sledování cesty. HDRP
používá strukturu k uložení sady světel, které ovlivňují každou oblast. Při
rastrování HDRP používá strukturu dlaždic pro neprůhledné objekty a struk-
turu clusterů pro průhledné objekty. Hlavní rozdíl mezi těmito dvěma struk-
turami a strukturami používanými pro sledování paprsku spočívá v tom, že
tato struktura není založena na zorném poli kamery (frustum). Pro sledování
paprsků vytváří HDRP mřížku zarovnanou s osami, která v každé buňce
ukládá seznam světel, který se má načíst, pokud v této buňce dojde k průniku.
Pomocí tohoto Volume Override můžete změnit, jak HDRP vytváří tuto
strukturu.

Funkci Light Cluster je také nutné povolit v HDRP assetu. Způsob je
obdobný jako u předchozích funkcí.

Vlastnosti ovlivňující chování funkce Light Cluster

.Maximum Lights Per Cell - Nastavuje maximální počet světel, které
může jednotlivá buňka uložit.. Camera Cluster Range - Nastavuje rozsah mřížky clusteru. Samotná
klastrová mřížka má střed v poloze kamery a rozprostírá se ve všech
směrech, protože mimo zorného pole kamery (frustum) se může objevit
průnik.

4.11 Path tracing

Sledování cesty je algoritmus sledování paprsku, který vysílá paprsky z kamery,
a když paprsek dopadne na reflektivní nebo refraktivní povrch, proces se
opakuje, dokud nedosáhne světelného zdroje. Série paprsků od kamery ke
světlu tvoří „cestu“. Umožňuje HDRP vypočítat mnoho různých efektů (jako
jsou tvrdé nebo měkké stíny, zrcadlové nebo lesklé odrazy, refrakce a nepřímé
osvětlení) v jediném jednotném procesu. Pozoruhodnou nevýhodou trasování
cest je šum. Šum však zmizí, jak se hromadí více cest, a nakonec konverguje
k čistému obrazu.
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................................. 4.12. Recursive rendering

Současná implementace sledování cesty v HDRP hromadí cesty pro každý
pixel až do maximálního počtu, pokud se kamera nepohybuje. Pokud se
kamera pohybuje, HDRP restartuje akumulaci cest. Sledování cesty podporuje
Lit, LayeredLit a Unlit materiály a plošná, bodová, směrová a ambientní
světla.

Sledování cesty sdílí obecné požadavky a nastavení jako ostatní funkce ray
tracingu. Sledování cesty používá Volume framework, takže pro použití této
funkce je nutné přidat Path Tracing override do Volume ve scéně. Toto se
provádí obdobným způsobem jako u předchozích funkcí.

Vlastnosti ovlivňující chování funkce Path tracing

.Maximum Samples - Nastavuje počet snímků, které se mají akumulovat
pro konečný obrázek. Ve spodní části zobrazení scény je ukazatel průběhu,
který ukazuje aktuální akumulaci vzhledem k této hodnotě..Minimum Depth - Nastavuje minimální počet odrazů světla v každé
cestě..Maximum Depth - Nastavuje maximální počet odrazů světla v každé
cestě. Je vždy vyšší nebo roven Minimum Depth. Pokud je Minimum a
Maximum Depth 2, je vizalizováno pouze nepřímé osvětlení.Maximum Intensity - Nastavuje zafixuje hodnotu intenzity světla, pro
kterou se každý odraz intenzity vrací. Umožňuje ignorovat velmi jasné
izolované pixely. Ztmavuje výsledný obraz.

4.12 Recursive rendering

Tato funkce je replacement pipeline pro vykreslování sítí v HDRP (High Defini-
tion Render Pipeline). GameObjects, které používají tento režim vykreslování,
vrhají refrakční a odrazové paprsky rekurzivně. To znamená, že když paprsek
zasáhne povrch, odrazí se nebo se lomí a pokračuje v zasažení dalších povrchů.
Můžete určit, kolikrát to paprsek udělá, aby vyhovoval vašemu projektu.
Hladkost materiálu neovlivňuje způsob, jakým se paprsek odráží nebo láme,
což činí tento režim vykreslování užitečným pro vykreslování vícevrstvých
průhledných GameObjects.

Recursive rendering cesty používá Volume framework, takže pro použití
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4. RTRT v Unity ....................................
této funkce je nutné přidat Recursive rendering override do Volume ve scéně.
Toto se provádí obdobným způsobem jako u předchozích funkcí.

Recursive rendering je nutné zapnout pro konkrétní objekty...1. Vyberte objekt ve scéně pro zobrazení v Inspectoru...2. Vyberte Material přiřazený ke objektu...3. Ve Surface Options foldout vyberte Raytracing z Rendering Pass drop-
down.

Můžete to také provést pro hlavní uzly Shader Graph:..1. V Project window proveďte double-click na Shader pro otevření v Shader
Graph...2. V hlavním uzlu klepněte na ozubené kolečko a poté v rozevíracím seznamu
Rendering Pass vyberte Raytracing.

Vlastnosti ovlivňující chování funkce Recursive rendering

. LayerMask - Definuje vrstvy, pro které HDRP zpracovává tento efekt..Max Depth - Řídí maximální počet odrazů nebo lomů paprsku před tím,
než se zastaví a vrací konečnou barvu. Zvýšení této hodnoty exponenci-
álně zvyšuje dobu provádění.. Ray Length - Řídí délku paprsků, které HDRP používá pro sledování
paprsků. Pokud paprsek nenalezne průnik, vrátí barvu oblohy.
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4. RTRT v Unity ....................................

Část II

Testovací aplikace a prostředí
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Kapitola 5

O aplikaci

Aplikace se skládá z hlavního menu a x testovacích scén, které jsou zaměřeny
na různé aspekty chování RTRT v Unity. Aplikace je postavená na HDRP
verze 7.3.1. Aplikace byla původně vytvářena v Unity 2019.3, ale později bylo
z důvodu vydání verze 2019.4, která není narozdíl od 2019.3 beta verzí, ale
jedná se o verzi s dlouhodobou podporou. RTRT obsažený ve verzích 2019.3
má některé zásadní rozdíly od RTRT obsaženého v 2019.4, ale tyto rozdíly
nejsou v práci zpracovány z důvodu, že Unity 2019.3 je již v současnosti
zastaralé.

Aplikace je ovládána kombinací klávesnice a myši. Ve většině scén se
vyskytuje avatar hráče v podobě jednoduchého robota ve tvaru kapsle. Tento
avatar slouží jako pohyblivá kamera a má schopnost jak chůze, letu a také
rozhlížení se ve stylu FPS her, což umožňuje prohlédnout si chování RTRT z
mnoha různých úhlů.

RTRT je v aplikaci možné vypnout a zapnout pouze z hlavního menu.
Důvodem tohoto, je že po přepnutí je z důvodu způsobu technického řešení
RTRT v Unity při přepnutí nutné znovu načíst scénu.
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Kapitola 6

Testovací scény

6.1 Scéna 1

Tato scéna se skládá z jednoduchého lesa s terénem a dvěma vodními plochami.
Testování ray tracingu se zde zaměřuje na efekt globálního osvětlení na objekty
bez ray tracing materiálů. Na scéně je také zapnutá mlha.

Klíčové prvky scény:

. Stromy - Globální iluminace osvětlí jinak neosvětlené části, jako spodní
strany větví, atd. . .. Terén - I když není podporovaný ray tracingem, tak je na něm dobře
efekt viditelný globální iluminace.

6.2 Scéna 2

Scéna se skládá z malého domu s malou zahradou. Testování se zde zaměřuje
na chování RTRT v interiéru, ray tracing stínů, průhledné materiály a lesklé
předměty.
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6. Testovací scény....................................
Klíčové prvky:

.Okna -Průhlednost a odrazy okolí, ztráta kvality díky šumu.. Zrcadla - Odrazy a vysoký šum.. Lampy - Real Time ray tracing stínů.

Rtrt materiály:

. zrcadlo: rendering pass ray tracing, maximální parametry metallic a
smoothness, base map bílá barva.. sklo: rendering pass ray tracing, maximální parametr smoothness, nízký
metallic, base map bílá barva, alpha 26.

6.3 Scéna 3

Scéna je část moderního města s krajinou okolo. Ve středu města se nachází
vodní nádrž a kolem ní výškové budovy. Testování ray tracingu se v této scéně
zaměřuje na odrazy a rekurzivní rendering.

Klíčové prvky scény:

.Mrakodrap skleněný - sledovaní odrazu okolí a obzoru - viditelné problémy
rtrt – neodráží se terén. Vodní plocha - Je tvořena materiálem, který má vlastní vertex sha-
der. - Vertex shadery nejsou ray tracingem podporované, a proto není
v odrazech viditelná.

Rtrt materiály

. sklo: rendering pass ray tracing, vysoké parametry metallic a smoothness,
base map šedá barva.
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....................................... 6.4. Scéna 4

6.4 Scéna 4

Scénu tvoří dvě plochy, tři particle efekty, krychle a deformovaná koule. Tato
scéna ukazuje že particle efekty ještě nejsou podporovány ray tracingem, a
také ukazuje deformaci obrazu způsobenou indexem lomu.

Klíčové prvky scény:

. Particle efekty - Ukazují že nejsou podporovány ray tracingem.. Plochy - Neodrážejí particle efekty..Koule - Zakrývá particle efekt a také deformuje obraz krychle.

6.5 Scéna 5

Scénu tvoří čtyři plochy, šestnáct krychlí a čtyři koule s bodovými světly.
V této scéně se testuje rekurzivní rendering a odrazy světel.

Klíčové prvky:

.Krychle - slouží jako ukázka RTRT na pohybujícím se objektu..Koule - Obíhají okolo svého bodu

RTRT materiály

.materiál krychlí: má bílou barvu, maximální parametr metallic a skoro
maximální smoothness..materiál koulí je průhledný, má minimální parametr metallic a velmi
nízký smoothness, má zelenou barvu a alfu 183, je emisivní, s intenzitou
100Nits.
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6. Testovací scény....................................
6.6 Scéna 6 až 9

Scéna 6 se skládá z jednoho čtverce podlahy, na kterém je umístěno několik
kusů nábytku a jiných assetů použitých v ostatních scénách a jednoho zrcadla.
Všechny assety mají rendering pass nastavený na ray tracing. Scéna 7 se
skládá ze čtyř těchto čtverců, scéna 8 z devíti a scéna 9 z šestnácti. Cílem
těchto scén je zjistit náročnost RTRT v závislosti na počtu renderovaných
objektů při vysokém nastavení všech overridů.
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Kapitola 7

Testovací prostředí

Pro testování byla použita sestava hardwaru:

AMD Ryzen 7 1700X
8 jader procesoru
16 vláken
Base Clock 3.4GHz
Max Boost Clock 3.8GHz
L1 Cache 768KB
L2 Cache 4MB
[AMD]

NVIDIA GeForce GTX 1080
Architektura GPU - Pascal
Snímkový zásobník - 8 GB GDDR5X
Rychlost paměti - 10 Gbps
Boost Clock - 1733 MHz
[Cor]

16GB RAM
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Část III

Testování a zhodnocení výsledků
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Kapitola 8

Testy

Byly provedeny testy všech scén se statickou kamerou a také u prvních 3 scén
byl proveden test s průchodem scénou.
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Kapitola 9

Výsledky testů

Hodnoty výsledků testů udávají GPU time.
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9. Výsledky testů ....................................
Scéna 1

Kamera 1 Kamera 2 Kamera 3
Globalni osvetleni 35,72 37,71 37,34
Bez Globalniho
osvetleni

35,46 37,52 37,29

Bez RT 35,38 37,28 36,69

Tabulka 9.1: Scéna 1 výsledky.

Obrázek 9.1: Scéna 1 RTRT s GI

Scéna 2
Kamera 1 Kamera 2 Kamera 3

Globalni osvetleni 419,39 602,48 152,97
Bez Globalniho
osvetleni

111,38 113,08 114,83

Bez RT 27,77 22,6 34,48

Tabulka 9.2: Scéna 2 výsledky.

Scéna 2 noc
Kamera 1 Kamera 2 Kamera 3

Globalni osvetleni 798,39 882,72 222,03
Bez Globalniho
osvetleni

138,95 176,83 164,67

Bez RT 49,14 37,5 57,54

Tabulka 9.3: Scéna 2 noc výsledky.
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.....................................9. Výsledky testů

Obrázek 9.2: Scéna 2 RTRT s GI

Scéna 3
Kamera 1 Kamera 2 Kamera 3

Globalni osvetleni 82,44 68,5 67,72
Bez Globalniho
osvetleni

57,03 55,15 54,39

Bez RT 68,06 52,36 50,58

Tabulka 9.4: Scéna 3 výsledky.

Obrázek 9.3: Scéna 3 RTRT s GI pohled do přízemí

Scéna 4
Kamera 1

Globalni osvetleni 65,13
Bez Globalniho
osvetleni

41,39

Bez RT 16,74

Tabulka 9.5: Scéna 4 výsledky.

41 ctuthesis t1606152353



9. Výsledky testů ....................................

(a) : Scéna 3 normální vykreslení

(b) : Scéna 3 RTRT

(c) : Scéna 3 RTRT s GI
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.....................................9. Výsledky testů

Scéna 5
Kamera 1 Kamera 2 Kamera 3

Globalni osvetleni 111,76 117,15 94,93
Bez Globalniho
osvetleni

69,92 74,21 55,65

Bez RT 6,85 6,13 7,88

Tabulka 9.6: Scéna 5 výsledky.

Scéna 5
Scéna 6 Scéna 7 Scéna 8 Scéna 9

Globalni osvet-
leni

32,97 79,42 153,39 313,32

Bez Globalniho
osvetleni

20,26 41,03 67,84 93,67

Bez RT 11,85 19,85 26,18 25,41

Tabulka 9.7: Scéna 6-9 výsledky.

Obrázek 9.5: Graf průchod scénou 1

Obrázek 9.6: Graf průchod scénou 2
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9. Výsledky testů ....................................

Obrázek 9.7: Graf průchod scénou 2 noc

Obrázek 9.8: Graf průchod scénou 3
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Kapitola 10

Zhodnocení výsledků

10.1 Scéna 1

Použítí Global Illumination mělo na této scéně pozitivní vliv na grafickou
kvalitu a zároveň němelo výrazný dopad na výkon. Z tohoto lze usuzovat, že
použití Global Illumination ve scénách bez ray tracing materiálů může mít
pozitvní vliv na kvalitu osvětlení a zároveň nízký dopad na výkon.

10.2 Scéna 2 den a noc

Použití Global Illumination mělo na této scéně velmi výrazný vliv na výkon,
což ukazuje že na použité hardwarové sestavě není global ilumination použi-
telný pro scény s velkým počtem světel. RTRT bez GI je na tomto typu scény
s použitou sestavou hardwaru na hranici použitelnosti z hlediska výkonu.
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10. Zhodnocení výsledků.................................
10.3 Scéna 3

Ve této scéně je RTRT jak s tak i bez GI z hlediska výkonu dobře použitelný
a obě varianty výrazně zlepšují grafickou kvalitu. Největšími problémy v této
scéně jsou nekompatibilita s shaderem vody a terénem(neodráží s v oknech
mrakodrapů).

10.4 Scéna 4

Tato scéna demonstruje chování RTRT v kombinaci s částicovými efekty.
RTRT je částicovými efekty zatíženo, ale výsledek se neliší od normálního
vykreslení.

10.5 Scéna 5

Tato scéna obsahuje velké množství objektů s lesklými ray tracing mate-
riály což je také přícinou několikanásobné doby vykreslování, při použítí
RTRT, grafická kvalita této scény při normálním vykreslování však není
vůbec realistická.

10.6 Scéna 6-9

Výsledky testů z těchto scén ukazují, že výpočetní náročnost RTRT roste s
velikostí scény, ale naštěstí je tento růst pomalejší než lineární. Růst výpo-
četní náročnosti globálního osvětlení je na scéně takovéhoto typu přibližně
lineární. Růst počtu světel na těchto scénách je táké lineární, takže je velmi
pravděpodobná přímá souvislost mezi těmito dvěma hodnotami.
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.................................. 10.7. Průchodové testy

10.7 Průchodové testy

Grafy ukazují, že na této hardwarové sestavě nelze RTRT použít k herním
účelům, protože graf ukazuje rendering time a v případě, že se blíží k hornímu
okraji obrazovky FPS jsou extrémně malé 10 a méně, v některých případech
i <1.
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Kapitola 11

Závěr

Přestože sada funkcí Unity Real-Time Ray Tracing není v současnosti zcela
kompletní, tak je již možné tuto sadu funkcí v konkrétních případech využít
k výraznému zlepšení graficke kvality. Nejvíce limitujícími faktory pro využítí
této sady funkcí jsou její hardwarové požadavky a nekompatibilita s vizuálními
efekty a terénem.
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Přílohy
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Příloha A

Návod

Hlavní menu

. Vypnout program: *. Zapnout a nebo vypnout RT: +. Spouštění scén = číslo scény. Rozlišení 1920x1080: m. Rozlišení 1280x720: n

Scény 1 a 2

. Změna času (rotace směrového světla): K(+10) a L(-10)

Scény 1-5

. Pohyb vpřed: W. Pohyb vzad: S. Pohyb doleva: A
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A. Návod .......................................
. Pohyb doprava: D. Zrychlení pohybu (10x): Left Shift. Přepínání letového módu: F. Let nahoru: Space. Let dolů: Left Ctrl. Statické kamery: 1, 2, 3.Kamera hráče: 0

Všechny RTRT scény

. Přepínání globální iluminace: G

Všechny Scény

. Zapnutí/vypnutí kurzoru: i. Návrat do Menu: Esc. Rozlišení 1920x1080: m. Rozlišení 1280x720: n
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Příloha B

Literatura

[AMD] Inc Advanced Micro Devices, Amd ryzen 7 1700x processor product
information.

[Cor] NVIDIA Corporation, Nvidia geforce gtx 1080 product information.

[ea19] Haines et al., Ray tracing gems, Apress, 2019.

[Tec] Unity Technologies, Hdrp 7.3 package documetation.
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